Microsoft, Windows, Windows NT, Windows 2000, Windows XP, and SQL Server are registered trademarks of Microsoft Corporation. Sybase is a registered trademark of Sybase, Inc. Java runtime environment is either a trademark or registered trademark of Sun Microsystems, Inc. or its subsidiaries in the United States and other countries. Adobe and Acrobat are trademarks or registered trademarks of Adobe Systems, Inc. All other product or company names are trademarks or registered trademarks of their respective companies.
## Contents

### CHAPTER 1

**Getting Started** ................................................................. 1-1

- Welcome .................................................................................. 1-3
- About This Guide .................................................................... 1-3
  - Chapters ................................................................................ 1-3
  - Online Guides and Web Updates ........................................ 1-4
  - Feedback ............................................................................. 1-4
  - Disclaimer ........................................................................... 1-4
- Conventions .............................................................................. 1-5
  - Mouse Conventions ................................................................ 1-5
  - Keyboard Conventions .......................................................... 1-5
  - General Conventions ............................................................ 1-5
- Horizon Basics....................................................................... 1-5
- Debt Collect Basics................................................................. 1-7
  - Overview of Debt Collect Tasks and Workflow .................. 1-7
  - Overview of the Debt Collect Administration Software ...... 1-9
  - Basic Debt Collect Task ...................................................... 1-10
    - Accessing the Debt Collect Administration Software .... 1-10

### CHAPTER 2

**Installing Debt Collect** ...................................................... 2-1

- About Installing Debt Collect ................................................ 2-3
- System Requirements ................................................................ 2-3
- Installing the Java Runtime Environment 1.6 ......................... 2-4
- Installing the Day End Process Software ................................. 2-5

### CHAPTER 3

**Setting Up Debt Collect** ..................................................... 3-1

- About Setting Up Debt Collect .............................................. 3-3
- Coordinating with the Collection Agency ............................ 3-4
- Assigning Security to a Staff User ......................................... 3-5
- Setting Up an Email Address .................................................. 3-6
  - Creating or Changing an Email Address ............................ 3-6
Getting Started

This chapter provides you with the basic information you need to begin using Debt Collect. It gives you an overview of this guide and an overview of Debt Collect.

Welcome 1-3
About This Guide 1-3
Horizon Basics 1-5
Debt Collect Basics 1-7
Welcome

Welcome to Horizon Debt Collect. Debt Collect lets you collect overdue books, fines, fees, and materials from borrowers with delinquent accounts through a collection agency. It automatically generates and outputs reports of delinquent borrower accounts, which it then can automatically send via email to a collection agency for recovery.

About This Guide

The Debt Collect Guide is for staff responsible for maintaining and communicating collection information about your library’s borrowers. It explains how to install and set up Debt Collect. It also explains other tasks you may want to do relating to Debt Collect. All setup and administration-related topics that are specific to Debt Collect are covered in this guide.

This section explains these topics:

- Chapters
- Online Guides and Web Updates
- Feedback
- Disclaimer
- Conventions

Chapters

This guide contains these chapters and major sections:

- Chapter 1, “Getting Started,” explains the basic information you need to begin using Debt Collect, and gives you an overview of this guide.
- Chapter 2, “Installing Debt Collect,” explains the system requirements for installing Debt Collect, what software programs you must install, and how to install them.
- Chapter 3, “Setting Up Debt Collect,” explains the tasks you must do to set up Debt Collect.
- Chapter 4, “Working with Day End Processes,” explains how to set up and use Debt Collect’s automated, “hands-off” processing.
- Chapter 5, “Working with Reports,” explains other tasks you may want to do with Debt Collect, including generating a report of all borrowers, viewing their information, printing a single report, and other tasks.
- Index to the guide.
Online Guides and Web Updates

In addition to the printed copy, this guide is available online as a PDF (Portable Document Format) file. To view any PDF file, you must install Adobe’s Acrobat Reader on your workstation. (This software is provided by Adobe free of charge.) You can download the latest version of Acrobat Reader from Adobe’s web site at “www.adobe.com”. Once you have installed the PDF files and Acrobat Reader, you access the files by opening them in Acrobat Reader.

You can access the most current PDF version of this guide at SirsiDynix’s customer web site at “customer.sirsidynix.com”. Accessing the Horizon Documentation site on the Web requires a login and password. If you do not already have a login and password, ask your system administrator to call Horizon Customer Support to receive the login and password.

Feedback

The Documentation Team at SirsiDynix wants to provide you with the most complete and useful documentation possible. If you have any comments about this guide, please let us know. We appreciate your feedback and we will use it to improve future versions of the guide. You can send your comments via email to “docs@sirsidynix.com”. If you need immediate assistance, contact your system administrator.

Disclaimer

The process names and sample windows in this guide reflect the default settings that are delivered with most new Horizon installations. The settings on your system may be different from these defaults, depending on your library’s implementation choices and the way your system administrator sets up your Horizon system. (For example, your system administrator can add fields to windows, reorganize the processes that display on the navigation bar, and set up security to limit access to certain processes.)

Additionally, as you use Horizon, you can resize windows or customize your Launcher workspace. Consequently, your Horizon environment may look and function differently than the environment described in the tasks in this guide. (For information about customizing and restoring window size or the Launcher workspace, see the Launcher Configuration Guide.)
Conventions

This section explains the documentation conventions used in this guide.

Mouse Conventions

- **Click.** To place the mouse pointer on an icon, command, or button and quickly press and release the primary (usually the left) button once.
- **Double-click.** To place the mouse pointer on an icon, command, or button and quickly press and release the primary mouse button twice.
- **Right-click.** To place the mouse pointer on an icon, command, or button and quickly press and release the secondary (usually the right) button.
- **Drag.** To press and hold the primary mouse button while moving the mouse.
- **Choose.** To select an option from a menu, group of options, or list.
- **Highlight.** To click once on an option in a list so the option is selected and displays in reverse video. In a field, you may drag the mouse over text to highlight that text.

Keyboard Conventions

- Keys on the keyboard are shown in uppercase, bold characters (for example, “the TAB key”). The keys on your keyboard may not be labeled exactly as they are in this guide.
- When you are instructed to press two or more keys at the same time, the keys are connected by a plus sign. (For example, `ALT+H` means to hold down the `ALT` key and press the `H` key.)
- Text or numbers that you are instructed to enter using the keyboard are enclosed in quotation marks (for example, enter “main” in the Location field).

General Conventions

- In step-by-step instructions, the names of menus, buttons, fields, and other options appear in bold typeface (for example, “the OK button” or “the Borrower field”).
- When you are instructed to choose an option from a menu, the menu and menu options are separated by commas. (For example, “choose File, Save” means to choose the File menu, then choose the Save option from the menu.)
- Text in italics shows general information that you must replace with information that is specific to your system. (For example, you would replace password with a specific password, such as 123gr@ndma.)

Horizon Basics

This guide assumes you have a basic knowledge of your Windows operating system, Horizon, and working in Horizon windows. At the minimum, you should know how to:

- Use a mouse or keyboard to do basic tasks, such as choosing menu options and buttons.
- Work with windows (selecting, moving, minimizing, restoring, maximizing, sizing, scrolling, closing, and so on).
- Work with dialog boxes.
- Log in to Horizon, change operators, and log off Horizon.
Chapter 1: Getting Started

• Search for records on the Horizon system.
• Work in Horizon list and edit windows.

**NOTE**

If you do not know how to do these tasks, see the Windows online help, your Microsoft Windows manual, or the *Horizon Basics Guide*.

Additionally, you should know how to:

• Use the Launcher environment, including activating a Horizon process.
  (For more information on working in the Launcher environment, see the *Horizon Basics Guide*.)

• Customize the Launcher, as necessary.
  (For instructions, see the *Launcher Configuration Guide*.)
Debt Collect Basics

Debt Collect lets you collect overdue books, fines, and fees from borrowers with delinquent accounts through a collection agency. It generates and outputs reports of delinquent borrower accounts, which it then can automatically send via email to a collection agency for recovery. (A report is a compiled list of your borrowers who qualify to be sent to a collection agency; the report includes information about the borrowers from your Horizon database, such as borrowers' names, addresses, phone numbers, and so forth.)

Before Debt Collect can do this all automatically, you must install some software programs and do some setup in Debt Collect and Horizon.

This section explains these topics:

- Overview of Debt Collect Tasks and Workflow
- Overview of the Debt Collect Administration Software

Overview of Debt Collect Tasks and Workflow

NOTE

This guide assumes that you know how to use the Table Editor. (For more information, see the Horizon System Administration Guide.)

Whenever you make a change to Horizon setup, you should exit Horizon and restart it on any workstation where you want the change to take effect.

Here is a summary of the Debt Collect tasks. This includes the tasks you must do to install and set up Debt Collect and the tasks that Debt Collect does once you set it up:

1 Install these software programs:
   - Java 1.6 Runtime Environment software.
   - Day End Process software.
   (For more information, see the “Installing Debt Collect” chapter.)

2 Coordinate with your collection agency.
   You must gather some information from your collection agency that you will use in setting up Debt Collect.
   (For more information, see “Coordinating with the Collection Agency” on page 3-4.)

3 Set up the email address for the collection agency and others to whom you want to send reports.
   (For more information, see “Setting Up an Email Address” on page 3-6.)
   If you do not want Debt Collect to automatically send reports via email, you can skip this task and see “Turning Off the Automatic Sending of Reports via Email” on page 4-7.

4 Define report criteria.
   A report is a compiled list of your borrowers who qualify to be sent to a collection agency; the report includes information about the borrowers from your Horizon database, such as borrowers’ names, addresses, phone numbers, and so forth. You must define what information about delinquent borrowers that you and your collection agency need on a report.
(For more information, see “Setting Up a Report” on page 3-11.)

5 Set up a group.
A group represents a location or set of locations for which you want a separate report generated.
When you set up a group, you also define collection parameters for borrowers from that location or locations, such as how long a borrower account can be delinquent before Debt Collect adds a borrower’s account to a report.
(For more information, see “Setting Up a Group” on page 3-18.)

6 Set up Day End to generate the reports.
Once you set up Day End to generate the reports, then Debt Collect automatically generates and sends the reports for each group that you have set up.
(For more information, see “Activating the Day End Processes for Debt Collect” on page 4-4.)

7 Debt Collect generates reports that list delinquent borrower accounts in both of these formats:
   - **Submit (New).** This report lists newly delinquent borrowers since the last Submit report.
   - **Update.** This report lists previously delinquent borrowers who have had any kind of activity on their account—from a small payment to completely settling their account with the library—since the last Submit (New) or Update report.

8 Debt Collect saves reports in a text file, then sends the reports to your collection agency via email (if you choose to have Debt Collect send the reports via email).
If you do not want Debt Collect to automatically send reports via email, you can keep it from doing so. (For example, since Debt Collect does not encrypt the borrower information in the email message, you may want to encrypt the report information with encryption software before sending it in an email message.) If you do this, then you must send the reports manually using email or by printing them and mailing them.
(For instructions about turning off automatically sending reports via email, see “Turning Off the Automatic Sending of Reports via Email” on page 4-7.)
The collection agency contacts borrowers from the report for debt recovery, then forwards the information to you.

How the collect agency sends collection and recovery information to you depends on the collection agency and what arrangements you have made with the agency.

The next time you generate a report, Horizon updates borrower accounts in Debt Collect to show which borrowers have paid overdue fines and fees, based on the activity recorded on your Horizon system.

If you want to do so, you can view the most recent Debt Collect information about borrowers and their blocks.

(For more information, see “Viewing Information about Borrowers and Their Blocks” on page 5-4.)

If necessary, you can print a full report of the most current borrowers who qualify for collection and their information.

(For more information, see “Viewing Information about Borrowers and Their Blocks” on page 5-4.)

If you want to do so, you can archive or delete old Debt Collect reports and files.

(For more information, see “Archiving or Deleting Old Debt Collect Reports and Files” on page 5-7.)

---

**Overview of the Debt Collect Administration Software**

When you first install Debt Collect, you install these software programs:

- Java 1.6 Runtime Environment software.
- Day End Process software.

After you install the required software, you must do some setup tasks. You do most of your setup tasks in the Debt Collect Administration in the Horizon table editor.
Here is an example of the main window in the Debt Collect Administration software:

These functions let you create and maintain groups. (A group represents a location or locations for which you want Debt Collect to generate a single report.)

After you install Horizon, you access this main window in the software from the table editor.

### Basic Debt Collect Task

After Debt Collect is installed, you can access the main Debt Collect window to complete most setup and collection tasks. Before you make changes in Debt Collect, you must be sure that no Debt Collect Day End processes are running.

**IMPORTANT**

This basic Debt Collect task assumes that your administrator has completed the installation tasks. (For more information, see “About Installing Debt Collect” on page 2-3.)

This section explains this topic:

- Accessing the Debt Collect Administration Software

### Accessing the Debt Collect Administration Software

After you install the Debt Collect Administration software, you can access the software from the table editor.

**To access the Debt Collect Administration software**

1. Open the Horizon client and log in.
2. Go to Administration > Table Editor.
3. Select the debt_collect table, and then click OK.
The Debt Collection Group dialog box displays.
Installing Debt Collect

This chapter explains how to install the software programs you need to use Debt Collect.

- About Installing Debt Collect 2-3
- System Requirements 2-3
- Installing the Java Runtime Environment 1.6 2-4
- Installing the Day End Process Software 2-5
About Installing Debt Collect

To use Debt Collect, you must install (or already have installed) these programs:

- Horizon 7.5 client software.
- Java 1.6 Runtime Environment software.
- Debt Collect Day End Process software.

The Debt Collect installation CD only contains the Debt Collect Day End Process software. The Horizon Client and Java 1.6 Runtime Environment software are on the Horizon 7.5 installation CD. After you install these software programs, you can set up Debt Collect, then let Debt Collect generate reports and send them to collection agencies and others.

Before you install any of the required software, you should be sure your workstations meet the system requirements.

**IMPORTANT**

You must contact SirsiDynix Support for help installing Debt Collect. Schedule this installation for a time when your library is not busy.

This chapter explains these topics:

- System Requirements
- Installing the Java Runtime Environment 1.6
- Installing the Day End Process Software

**System Requirements**

To install the software programs for Debt Collect, your library must meet these system requirements:

- Your library system must be running Horizon 7.5 or higher.
- The workstation on which you install the Java 1.6 Runtime Environment and Debt Collect Day End Process software programs must be running Windows 2000 or Windows XP.
Installing the Java Runtime Environment 1.6

The Debt Collect Day End Process software program is built on Java technology. Therefore, you must install Java Runtime Environment 1.6 software. (If you already have a different version of Java installed, you should still install this version.)

You can get the JRE 1.6 from any of the following locations:

- Horizon 7.5 Install CD-ROM
- Horizon SIP2 Responder 1.0 Install CD-ROM
- Horizon Information Portal 3.20 Install CD-ROM
- Direct from the Sun Microsystems website at http://www.java.com

To install Java Runtime Environment 1.6

1. Start the Java JRE 1.6 install.
   The installation program displays the Software Licensing Agreement window.

2. Click Accept to accept the terms of the license agreement.
   The installation program installs the Java 1.6 software.

3. Click Finish.

4. Continue with the task “Installing the Day End Process Software” on page 2-5.
Installing the Day End Process Software

The Debt Collect Day End Process program installs. This process chooses the borrowers to put in the Debt Collect reports, generates the reports, and sends the reports in an email message—depending on your Debt Collect settings.

This program also lets you use Day End processes for Debt Collect. (These processes are named “DeDebtN” and “DeDebtU”. For more information, see “Activating the Day End Processes for Debt Collect” on page 4-4.)

Before You Begin

Uninstall your previous version of the Day End Process software. (For information on uninstalling a program, see Windows online help or your Microsoft Windows manual.)

To install the Debt Collect Day End Process software

1. Insert the Debt Collect installation CD into your CD-ROM drive.
   The installation program displays the Debt Collect Install window.

2. Click Debt Collect.
   The installation program displays the Introduction screen.

3. Click Next to continue.
   The installation program displays the Choose Install Folder screen.

4. Click Next to accept the default location in which you want the program installed, or choose a new location.
   The install location must be the same folder where you installed the Horizon client.
   The installation program displays the Choose Java Virtual Machine screen.

5. Select the Java version to use with Debt Collect. The version must be Java 1.6 or higher.
   If the Java installation you want to use is not listed, click Search Another Location to browse for a folder where the desired install is located, or click Choose Java Executable to select the Java EXE file to use.

6. Click Next to continue.
The installation program displays the Horizon Database Connection Information screen.

7 Choose your database type of the Horizon database, either Sybase or Microsoft SQL.
8 Complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>Enter the password to access your Horizon database. (For example, enter “12345”).</td>
</tr>
<tr>
<td>Database Name</td>
<td>Enter the name of your Horizon database. (For example, enter “horizon”).</td>
</tr>
<tr>
<td>IP Address or Database Server Name</td>
<td>Enter the IP address or name of the server on which your Horizon database resides. (For example, enter “192.10.192.192” or “hznservicer”).</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the port number on which your Horizon server listens. (For example, enter “5000”).</td>
</tr>
<tr>
<td>User</td>
<td>Enter the user name or ID to access your Horizon database. (For example, enter “sa”).</td>
</tr>
</tbody>
</table>

**NOTE**
This database user name must have database owner (dbo)-type permissions for the Horizon database you are accessing.

9 Click **Next** to continue.
The installation program displays the Enter Password screen.

10 Type the password for the previously-specified user of the Horizon database.

11 Click **Next** to continue.
The installation program displays the Pre-Installation Summary screen.

12 Verify that the information for installing the client software is correct, and then click **Install**.
The installation program copies the client files.

13 Click **Done**.

14 Click **Exit**.
Setting Up Debt Collect

This chapter explains how to set up Debt Collect, including coordinating with a collection agency, defining the report criteria, defining how borrowers qualify for collection, activating the Debt Collect Day End processes, and so forth.

- About Setting Up Debt Collect  3-3
- Coordinating with the Collection Agency  3-4
- Assigning Security to a Staff User  3-5
- Setting Up an Email Address  3-6
- Setting Up a Report  3-11
- Setting Up a Group  3-18
About Setting Up Debt Collect

Debt Collect automatically creates reports and sends them in an email message. (A report is a compiled list of your borrowers who qualify to be sent to a collection agency; the report includes information about the borrowers from your Horizon database, such as borrowers’ names, addresses, phone numbers, and so forth.) Whenever you run Day End, Debt Collect gathers the information it needs from your Horizon database to create a report. It then sends the report to the collection agency or others who you want to receive reports—all automatically.

To have Debt Collect do this automatically, you must set up Debt Collect with the information it needs. You set up Debt Collect by doing these tasks:

1. Coordinating with your collection agency.
   You must gather some information from your collection agency that you use in setting up Debt Collect.
   (For more information, see “Coordinating with the Collection Agency” on page 3-4.)

2. Assigning the staff user to the appropriate security group with required permissions for their role with Debt Collect.
   (For more information, see “Assigning Security to a Staff User” on page 3-5.)

3. Setting up the email address for the collection agency and anyone else that you want to receive reports.
   (For more information, see “Setting Up an Email Address” on page 3-6.)
   If you do not want Debt Collect to automatically send reports via email, skip this task and see “Turning Off the Automatic Sending of Reports via Email” on page 4-7.

4. Defining report criteria.
   A report is a collection of delinquent borrowers and their related information that you send to a collection agency for the collection agency to use in collecting the fines, fees, and materials for your library. You must define what information about delinquent borrowers you and your collection agency need on a report.
   (For more information, see “Setting Up a Report” on page 3-11.)

5. Setting up a group for each location for which you want a separate report generated.
   When you set up a group, you also define collection parameters for borrowers from that location or locations, such as how long a borrower account can be delinquent before Debt Collect adds a borrower’s account to a report.
   (For more information, see “Setting Up a Group” on page 3-18.)

6. Setting up Day End to generate the reports.
   Once you set up Day End to generate the reports, then Debt Collect automatically generates and sends the reports that you have set up.
   (For more information, see “Activating the Day End Processes for Debt Collect” on page 4-4.)
If you do not want Debt Collect to automatically send reports via email, you can keep it from doing so. (For example, since Debt Collect does not encrypt the borrower information in the email message, you may want to encrypt the report information with encryption software before sending it in an email message.) If you choose to turn off this feature, then you must send the reports manually using email or by printing the reports and mailing them.

**NOTE**

This chapter assumes that you know how to use the Table Editor. (For more information, see the *Horizon System Administration Guide*.)

Whenever you make a change to Horizon setup, you should exit Horizon on all workstations and log back in. This assures that any changes take effect.

This chapter explains these topics:

- Coordinating with the Collection Agency
- Assigning Security to a Staff User
- Setting Up an Email Address
- Setting Up a Report
- Setting Up a Group

## Coordinating with the Collection Agency

Debt Collect is designed to work in conjunction with a collection agency to recover delinquent fines, fees, and materials from borrowers. There are several issues you should resolve with the collection agency before setting up Debt Collect.

Contact the collection agency to find out this information:

- What borrower information the collection agency needs you to include in the Debt Collect Submit (or New) report and the Debt Collect Update report. (A Submit report is a list of newly delinquent borrowers since the last Submit report. An Update report is a list of borrowers who have had any kind of activity on their account—from a small payment to completely settling their account with the library—since the last Submit or Update report.)

The collection agency may want different information on the Submit (New) report versus the Update report. You can even send a copy of a sample report to show the default information that appears.
Assigning Security to a Staff User

In order to work with the tables, borrower records, and reports, the staff user who needs to work with Debt Collect must have the appropriate security added to their login.

In order to access the Debt Collect Borrower Report (debt_borrower mq_view) staff members will need to have “CRC-Debt Collect Reports (Privilege #685)”.

---

Here is an example of a report with one borrower listed:

```
# Debt Collect for Horizon generated report --
# Submit Report generated: 11 Apr 2002 08:40:33 EDT
# Borrowers: 1
------- 22001
name=KTTJ, J OBN C.
addr=700 S. West Ave.
addr=
addr=
city_st=Centerville, ST
zip=49203
birth=
acct=22001
phone=555-555-1022
bphone=
totamt=125.10
datedate=09 Jan 2003
parent=
btype=s
ss=23061
income=0.00|car=115.28|con=0.00|ess=0.00|gra=0.00|heu=0.00|hei=0.00|hsp=0.00|psc=0.00|tac=0.00|apt=0.00|sw=0.00
### END
```

- How frequently the collection agency wants you to send the report (daily, weekly, or monthly).
  The collection agency may want an Update report daily and a Submit (New) report weekly, or vice versa.
- Email information.
  Ask the contact person at your collection agency for this information:

  - Email address to which the collection agency wants your library’s reports sent.
  - Contact person at the collection agency, or the person to whom the email address belongs.
  - Name of the collection agency.

You may want to ask the contact person if you can test the email address using your library’s email program. This way, you can verify that the email address works. (Debt Collect does not display an error message letting you know that an email address was invalid or that a report was not sent.)

- Fees from the collection agency (such as processing fees).
  Find out what fees the collection agency charges your library for their services. If you want to do so, you can use Debt Collect to add these fees to the fine amounts borrowers already owe.
In order to access the Debt Collect Administration (debt_control, debt_email, and debt_report mq_views) staff members will need to have “CRC – Debt Collect Admin (Privilege#686)”.

You will need to either assign these permissions to an existing role, or create a new role with these permissions. Then, you need to assign the role to a group, and then assign the staff login to that group. For more details about how to do this, see the “Security and Preferences” chapter of the Horizon System Administration Guide.

Setting Up an Email Address

If you want Debt Collect to automatically send reports via email, then you must enter the email addresses to which you want the reports sent. (If you do not want Debt Collect to automatically send reports via email, skip this task and see “Turning Off the Automatic Sending of Reports via Email” on page 4-7.) You should set up an email address for each collection agency to which you want to send reports in email messages. You can also send reports to yourself, a supervisor, or anyone else who needs to view the reports.

All of the groups in Debt Collect use this same list of email addresses that you set up, so you need to set up each email address only once.

You can also change any of the email information at any time. If you no longer want to have an email address in your list, you can delete it.

This section explains these topics:

- Creating or Changing an Email Address
- Deleting an Email Address
- Changing the Display of the Email Pool List

Creating or Changing an Email Address

You should set up the email address for each collection agency to which you want to send reports in email messages. Then, you can assign the email address to a group or groups. (You should assign the email address to the group or groups whose reports you want sent to that email address.) If you have different groups and reports for different collection agencies, then you should set up the email address for each collection agency. You can also send reports to yourself, a supervisor, or anyone else who needs to view the report.

If necessary, you can change any of the email information at any time.

Before You Begin

When you set up an email address, you enter specific information about the person to whom you are sending the email message. You may want to gather this information from the collection agency or person to whom you are sending the email report, if you do not already have it:

- Email address to which you are sending the report.
- Contact person at the collection agency, or the person to whom the email address belongs.
- Name of the collection agency or other organization information, if any.

In addition to gathering the information from the person to whom you are sending the email report, you may want to ask the person if you can test the email address using your library’s email program. This way, you can verify that the email address works.
To create or change an email address

1. Be sure that you are not running the Debt Collect Day End processes.
2. In the Horizon Client, go to Administration > Table Editor.
3. Select the debt_email table, and then click OK.
   The Debt Collection Email Pool dialog box displays.
Do one or more of these tasks, as necessary:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Create a new email address      | 1 Click **New**. Debt Collect opens the Edit: Debt Collection Email Pool dialog box.  
|                                 | 2 Complete these fields:                                               |
|                                 |   • **Email Address.** Enter the email address to which you want to send reports.  
|                                 |   • **Name.** Enter the name of the person to whom the email address belongs.  
|                                 |   • **Organization.** Enter the name of the collection agency or other organization.  
|                                 | 3 Click **Save** and then **Close**.                                    |
| Change email address information| 1 Click the row with the email information that you want to change.     |
|                                 | **NOTE**                                                               |
|                                 |   If you click once, Debt Collect highlights the row so you can click **Edit**. You can also double-click the row to automatically open the record for editing.  
|                                 | 2 Enter the new information for the fields:                            |
|                                 |   • **Email Address.** Enter the email address to which you want to send reports.  
|                                 |   • **Name.** Enter the name of the person to whom the email address belongs.  
|                                 |   • **Organization.** Enter the name of the collection agency or other organization.  

Repeat step 4 for other email addresses that you may want to create or change.

**NOTE**

To use the email addresses that you create, you must assign them to a group or groups. (For instructions, see “Changing a Group” on page 3-21.) Each person at the email addresses that you assign to a group will receive a Submit (New) and Update report for that group every time Debt Collect generates the reports. You can assign an email address to more than one group, if you want the person at the email address to receive the reports for each of the groups.

**Deleting an Email Address**

If you no longer want an email address in your list of addresses, you can delete it from the list.
Setting Up an Email Address

Before You Begin
If this email address is assigned to a group, you must unassign it in the group before you can delete it from Debt Collect. (For instructions, see “Changing a Group” on page 3-21.) If you do not know how many groups have referenced an email address, you can attempt to delete the email address; Debt Collect displays an error message that lists the number of groups that reference the email address.

To delete an email address
1. Be sure that you are not running the Debt Collect Day End processes.
2. In the Horizon Client, go to Administration > Table Editor.
3. Select the debt_email table, and then click OK.
4. Click on the email row that you want to delete.
5. Go to File > Delete Record.
6. Click OK to confirm the deletion.

Debt Collect deletes the email address from the list.

Changing the Display of the Email Pool List
You can change the sorting and columnar display in the Debt Collection Email Pool list.

To change the display of the Email Pool list
1. Be sure that you are not running the Debt Collect Day End processes.
2. In the Horizon Client, go to Administration > Table Editor.
3. Select the debt_email table, and then click OK.
4. To change the sort method used, click Sort.

The Choose Sort Columns dialog box displays.

Do the following:
- Select one or more columns from the list (up to a maximum of 15).
The columns reorder in the list according to the order in which you select them. Thus, the order of sort depends on the order of the columns in the list. For example, in the preceding image, the list is sorted first by ID, then by the email address, then the persona’s name, and finally by the name of the organization.

- Select **Descending sort** to reverse the sort order (from A-Z to Z-A and from 0-9 to 9-0). This changes the sort order for all the columns.
- Click **OK** to save the changes.

5. To change the display of columns, click **Display**. The Display Options dialog box displays.

Do the following:

- Select the columns that display by highlighting the appropriate ones. Clicking a highlighted column turns off its highlighting and hides the column in the Email list dialog box.
- From the **Display properties** list, select the column that you want to change values for.
- Specify the column’s **Position** (the order it appears from left to right).
- Specify the **Width** of the column. The value specified is in terms of the number of characters to display.
- Specify a **Label** for the column.
- Select whether to **Right justify** the column contents or to leave the contents left-justified.
- Repeat the second through the sixth bullet item for each column.
- Click **OK** to save your changes.
Setting Up a Report

You can define the report criteria that Debt Collect uses to generate reports. This way, Debt Collect knows what borrower information to put on each report for the collection agency or others. Debt Collect generates two reports: one Submit (also called “New”) report and one Update report.

Here is a description of the two report types:

- **Submit (New) Report.** This report contains a list of borrowers and their information (such as name, phone number, address, and so forth) who have qualified for collection since Day End generated the last Submit (New) report.

- **Update Report.** This report contains a list of borrowers and their information (such as name, phone number, address, and so forth) who have had any kind of activity on their account—from a small payment to completely settling their account with the library—since the last Submit or Update report.

Each group in Debt Collect must have at least a Submit (New) report and an Update report. This way, Debt Collect knows the location or locations to generate reports for. (For more information on groups, see “Setting Up a Group” on page 3-18.)

Debt Collect delivers two default reports (submit 1 and update 1). If you are setting up a report for the first time, you can change the default fields on the default reports to fit the needs of your location or locations and your collection agency. Debt Collect then gets its information from the fields on your Horizon borrower records and generates the reports.

Before you set up a report, you may want to view all of the fields that Debt Collect lets you put on a report, then discuss what kinds of information your collection agency needs in both the Submit (New) and Update reports.

This section explains these topics:

- Changing a Report
- Setting Up the Specifier for the Phone and Bphone Fields
- Changing the Display of the Report List
Chapter 3: Setting Up Debt Collect

Changing a Report

Before you set up your groups, you should set up the reports for the group: one Submit (also called “New”) report and one Update report. (A Submit report is a list of newly delinquent borrowers since the last Submit report. An Update report is a list of borrowers who have had any kind of activity on their account—from a small payment to completely settling their account with the library—since the last Submit or Update report.) This way, Debt Collect knows what information to put on each report for the collection agency and others.

Debt Collect delivers two default reports (submit 1 and update 1). If you are setting up a report for the first time, you can change the default fields on the report to fit the needs of your location or locations and your collection agency. Debt Collect then gets its information from the fields on your Horizon borrower records.

Before You Begin

If you have not already done so, you should ask your collection agency what borrower information the collection agency needs you to include in the Debt Collect Submit (or New) report and the Debt Collect Update report.

The collection agency may want different information on the Submit (New) report versus the Update report. You can even send a copy of a sample report to show the default information that appears.

To change a report

1. Be sure that you are not running the Debt Collect Day End processes.
2. In the Horizon Client, go to Administration > Table Editor.
3. Select the debt_rpt table, and then click OK.
   The Debt Collection Reports dialog box displays.
4. Select a report from the list and click Edit.
Debt Collect displays the Report Edit window:

You must complete the required fields that are marked by an asterisk (*).

These fields come from those available in the Report Domain, which ultimately come from the borrower table on your Horizon database.

5 Change these fields, as necessary:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the report. (For example, if this is a submit report for Group 2, enter “submit 2”.)</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the report. (For example, if this is a submit report for Group 2 [the West branch location], enter “Submit Report for West (#2)”.)</td>
</tr>
</tbody>
</table>
6 Do one or more of these tasks, as necessary; otherwise, skip to step 7:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Change an existing field in the report  | 1 Select the field to change from the **Report Fields** drop-down. (For example, if you want to break down the amounts being submitted or updated on reports by location, then choose the “locamt” field for this report.)  
2 Assign the **Seq** value for the order in which the field appears in the report. This value must not already be assigned to an existing field.  
3 If necessary, type or choose a **Field Name** by clicking **Codes** and selecting the field name to use instead of the currently selected field. Debt Collect changes the field. |
| Insert a new field in the report        | 1 In the Report Fields area, click **New**. Debt Collect inserts the new blank field.  
2 Assign the **Seq** value for the order in which the field appears in the report. This value must not already be assigned to an existing field.  
3 Type or choose a **Field Name** by clicking **Codes** and selecting the field name to use. |
| Change the order of the fields in the report | In the **Seq** field, enter the number for the order in which you want this field to appear in the report. This value must not already be assigned to an existing field. |
| Delete a field from the report          | 1 Select the Report Field that you want to delete.  
2 Click **Delete**. Debt Collect deletes the field from the report. |

7 **Save** your changes and click **Close**.

8 Repeat steps 4 through 7 if you want to create or change another report.

---

**Setting Up the Specifier for the Phone and Bphone Fields**

If you want to use the phone or bphone fields on a report, then you should be sure that the specifiers for these fields are set up the way your library uses them. This way, Debt Collect knows how to put the information for these fields on a report or where to find the information.

**To set up the specifiers for the phone and, bphone fields**

1 Be sure that you are not running the Debt Collect Day End processes.
2 In the Horizon Client, go to **Administration > Table Editor**.
3 Select the **debt_rpt** table, and then click **OK**.
The Debt Collection Reports dialog box displays.

4 Select a report from the list and click **Edit**. Debt Collect displays the Report Edit window:

5 In the **Report Fields** drop-down list, select the phone field you want to edit.

6 Click **Codes**.
Chapter 3: Setting Up Debt Collect

The Code Lookup: Debt Collection Field Domain dialog box displays:

![Code Lookup: Debt Collection Field Domain](image1)

7 Click Edit.

The Edit: Debt Collection Field Domain dialog box displays:

![Edit: Debt Collection Field Domain](image2)

8 Type a **Specifier** and a **Description** for the Field Name you selected.

9 Click **Close** to save the changes.

10 Click **OK** to use the selected code.

11 Repeat steps 5-10 for each Phone Mapping for which you need to set up the specifier.

12 **Save** your changes and click **Close**.

### Changing the Display of the Report List

You can change the sorting and columnar display in the Debt Collection Reports list.
To change the display of the Reports list

1. Be sure that you are not running the Debt Collect Day End processes.
2. In the Horizon Client, go to Administration > Table Editor.
3. Select the debt_rpt table, and then click OK.
4. To change the sort method used, click Sort.
   The Choose Sort Columns dialog box displays.
   
   ![Choose Sort Columns dialog box]
   
   Do the following:
   - Select one or more columns from the list (up to a maximum of 15).
     The columns reorder in the list according to the order in which you select them. Thus, the order of sort depends on the order of the columns in the list. For example, in the preceding image, the list is sorted first by Group ID, then by the report Name, and finally by the Description of the report.
   - Select Descending sort to reverse the sort order (from A-Z to Z-A and from 0-9 to 9-0).
     This changes the sort order for all the columns.
   - Click OK to save the changes.
5. To change the display of columns, click Display.
The Display Options dialog box displays.

Do the following:

- Select the columns that display by highlighting the appropriate ones. Clicking a highlighted column turns off its highlighting and hides the column in the Debt Collection Reports list dialog box.
- From the Display properties list, select the column that you want to change values for.
- Specify the column's Position (the order it appears from left to right).
- Specify the Width of the column. The value specified is in terms of the number of characters to display.
- Specify a Label for the column.
- Select whether to Right justify the column contents or to leave the contents left-justified.
- Repeat the second through the sixth bullet item for each column.
- Click OK to save your changes.

Setting Up a Group

A group represents a location or set of locations for which you want a single report generated. You must set up a group so that you can decide what criteria qualifies borrowers to be submitted for collection for the location or locations in the group (such as when borrowers with overdue materials are sent to collection or which borrower types [BTYPEs] are excluded from collection).

Debt Collect delivers a default group (group 1). If you are setting up a group for the first time, you must change the default group settings to fit the needs of your location or locations and your collection agency. Most libraries need only one group; however, if your library is part of a consortia, then you may want to create more than one group to represent each location, if necessary. If you need to add a group, contact your SirsiDynix support representative for instructions.

When you set up a group, you can decide different parameters about the group, including some of these things:
Setting Up a Group

- General parameters that Debt Collect uses in gathering the information for a report (for example, the minimum fine amount, minimum borrower age, any grace period, and so forth).
- Collection agency email address to which Debt Collect sends reports for a library.
- Which reports to use for submit and update.
- Any processing fees incurred during fine processing.
- Which borrower types (BTYPEs) you may want to exclude from qualifying for collection.
- Which library locations you want to include in the group.
- Which location’s blocks to use for sending borrowers to collection.

How you use groups in Debt Collect is up to you and library staff at any other locations for which you are responsible. How many groups and what their parameters are depends on what you decide with the other locations involved with Debt Collect. (For example, if you have a library location that wants different parameters for qualifying borrowers for collection, then you may want to create a new group for that location.) Each location in a group should have the same parameters and use the same report for all of the locations in the group.

When you set up a group, you must do these tasks:

1. Change the settings of the default group to fit your needs and create any new groups, if necessary.
   (For more information, see “Changing a Group” on page 3-21.)

2. Assign library locations to a group.
   For each group you have, you must assign the library locations that you want. Each location’s debt collection information will be in the same report as all of the other locations in the group. (For more information, see “Assigning Library Locations to a Group” on page 3-34.)

3. Assign a submit and update report to the group.
   (For more information, see “Changing a Report” on page 3-12.)

4. Complete the setup for a group.
   For each group, you must do a few additional setup tasks in your Horizon database. (For more information, see “Completing the Setup for a Debt Collect Group” on page 3-40.)

In addition to the setup tasks that you must do, you can do these optional setup tasks for a group:

1. Assign a processing fee to a range of fines.
   (For more information, see “Assigning a Processing Fee to a Range of Fines (Optional)” on page 3-31.)

2. Exclude a borrower type (BTYPE) from qualifying for collection.
   (For more information, see “Excluding a BTYPE from Qualifying for Collection (Optional)” on page 3-38.)

Once you set up a new group, you can change it or delete it, as necessary.

This section explains these topics:

- Changing a Group
- Assigning a Processing Fee to a Range of Fines (Optional)
- Assigning Library Locations to a Group
- Excluding a Block Type from Qualifying for Collection (Optional)
- Excluding a BTYPE from Qualifying for Collection (Optional)
- Completing the Setup for a Debt Collect Group
Chapter 3: Setting Up Debt Collect

- Deleting a Group
Setting Up a Group

Changing a Group

A group represents a location or set of locations for which you want a single report generated. (The locations available for a group are those locations defined on your Horizon system.)

When you change a group, you can specify the collection parameters for that library or consortia, including these things:

- General parameters that Debt Collect uses in gathering the information for a report (for example, the minimum fine amount, minimum borrower age, any grace period, and so forth).
- Collection agency email address to which Debt Collect sends reports for a library.
- Processing fees associated with particular fine amounts.
- Borrower type to exclude from being sent to collection.
- Locations to include in the collection process.
- Location Kind for which location’s blocks to use for sending a borrower to collection.

Before You Begin

If you have more than one location for which you are responsible for setting up Debt Collect, you may want to view the parameters that you can set up for a group before you complete them. These parameters must apply to all locations that you assign to a group.

When you create a group of locations or assign a library location to a group, you choose the group’s “Location Kind.” The Location Kind determines which location’s blocks Debt Collect uses to send borrowers to collection. These are the two types of Location Kinds:

- **Transacting Location.** This is the location from which borrowers have checked out items or received other billable services that are now overdue.
  
  If you choose Transaction Location, Debt Collect associates blocks (and their related fines) with the locations that performed the transaction.

- **Owning Location.** This is the location that actually owns the library material or has it in their catalog.
  
  If you choose Owning Location, Debt Collect associates blocks (and their related fines) with the locations that actually own the library material or have the material in their catalog. (If the block entry is not for an item, and therefore has no owning location, Debt Collect uses the transacting location.)

If you want to collect fines for non-library-owned material or services (such as copying), you can use Transacting or Owning locations.

**IMPORTANT**

All locations within a group must have the same Location Kind (Transacting or Owning). In addition, all groups should be assigned the same Location Kind. (For example, if you create three groups, all three groups should be Transacting locations, or Owning locations.) Otherwise, borrowers may be included on more than one report and could be contacted and billed processing fees for each report they appear on. If you would like to use Transacting and Owning Location Kinds in your Debt Collect groups, contact Customer Support.
A transacting location is a location that performs checkout and other transactions; an owning location is a location that actually owns the library material or has it in their catalog. If library locations want to collect fines for non-library-owned material or services (such as copying), then you may want to choose the Transacting location kind.

**IMPORTANT**

Once you turn on the Debt Collect Day End processes and Debt Collect generates a report, you should not change the group parameters; this may cause undefined results. However, you can change the Day 1 Start Date to an earlier date. (For example, you can change the Start Date from 5/21/02 to 5/14/02.) If you need to change group parameters after Debt Collect has generated a report, you should consult with Customer Support. However, if you need to, you can turn off the Day End processes for the old group, create a new group with the changed information, then activate the Day End processes for the new group.

Also, you should coordinate with your collection agency when you make a change to a group. (For example, you may no longer want to collect on a certain borrower type [BTYPE] [or exclude the BTYPE from qualifying for collection]. You should notify your collection agency to stop collecting on borrowers with that BTYPE.)

To change a group

1. Be sure that you are not running the Debt Collect Day End processes.
2. In the Horizon Client, go to **Administration > Table Editor**.
3. Select the **debt_collect** table, and then click **OK**.
   
   The Debt Collection Group dialog box displays.

4. Do one of these options:
   
   - If you want to create a new group, contact your SirsiDynix support representative for more information.
• If you want to change an existing group, choose the group you want and click **Edit**.

Debt Collect displays the Debt Collection Group Edit dialog box:

5 Complete or change these fields, as necessary:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name that you want for the group. (For example, if you are using only one location in this group, you may want to enter the name of the location. If you are using more than one location in this group, you may want to use a descriptive name, such as “Eastern Branches” or “Central Consortia”.)</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description that you want for the group. (For example, if the group is for the “Eastern Branches,” enter the names of the eastern branches.)</td>
</tr>
</tbody>
</table>
### Chapter 3: Setting Up Debt Collect

**Field** | **Description**
---|---
Day 1 Start Date | Enter the earliest billing notice or burb entry date (m/d/yyyy) that Debt Collect should use to qualify borrowers for collection.

(For example, enter “4/24/2002”.)

If the start date is June 1, 2009 and the borrower owes $50.00, but $40.00 of it was created prior to 6/1/2009, their eligible balance is only $10.00. If the Amount Due Threshold is $25.00, this borrower would not be sent to Debt Collect. If they have another $50 added later, in July, they will get sent to Debt Collect at that time for the total amount owed of $100. This also assumes that all blocks were created at locations that are specified for the group (for more information, see “Assigning Library Locations to a Group” on page 3-34).

You choose which type of date (billing notice or burb entry) that you want Debt Collect to consider for the delinquent start date later in this table. (A burb entry is a block, which is entered in the burb table. For more information, see the “Blocks” chapter of the *Circulation Guide*.)

### IMPORTANT

You can have Debt Collect examine delinquent borrower records from as long ago as you choose. However, if this is the first time that you have used any version of Debt Collect, you may want to run Debt Collect for incremental ranges of dates instead of for a single large block of time. This is because running Debt Collect for a long period (for example, a year) can slow down your system while Debt Collect gathers all the necessary information, generates a report, and prepares and sends email notices.

For example, start by entering a Day 1 Start Date that is a month earlier than the date on which you want to begin generating reports and using Debt Collect. Complete the entire Debt Collect process for that month. Then move the Day 1 Start Date another month earlier and repeat the entire Debt Collect process. Continue moving the Day 1 Start Date back by monthly increments until you have gone back as far as you want to collect on delinquent borrower accounts.

### Amount Due Threshold

Enter the maximum amount that a borrower can owe before qualifying for collection.

If a borrower owes the same or less than the amount you enter, Debt Collect does not consider the borrower for collection.

For example, type “5.00” if you want to exclude borrowers that have less than $5.00 owing.
### Setting Up a Group

**Date Grace Period (Days)**

Enter the number of days that you want to allow for a grace period in relationship to the Day 1 Start Date.

(For example, enter “5” for a grace period of five days.)

Debt Collect does not consider borrowers for collection if they have any burb activity within this grace period (for example, a payment, waiver, billing notice, or overdue items).

(For example, if the “Day 1” date is “4/24/2008”, the grace period is five days, and today’s date is “5/31/2008”, then Debt Collect uses the date range 4/24/2008 through 5/26/2008 as the dates that qualify for collection.)

**Date to Use**

Choose one of these options:

- **Burb Entry.** Choose this option if you want Debt Collect to use the date the entry was made in the burb table (a table containing borrower blocks) for the overdue item when choosing blocks for collection. (For more information, see the “Blocks” chapter of the *Circulation Guide.*)

- **Billing Notice.** Choose this option if you want Debt Collect to use the date of the billing notices when choosing blocks for collection.

  **NOTE**

  If you choose this, you must also choose a Billing Notice option (oldest or newest). Also, Debt Collect’s processing for this option is slower than for the Burb Entry option.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processing Fees</td>
<td>You can specify fees that are associated with a range of fines. For more information, see “Assigning a Processing Fee to a Range of Fines (Optional)” on page 3-31.</td>
</tr>
<tr>
<td>Date Grace Period (Days)</td>
<td>Enter the number of days that you want to allow for a grace period in relationship to the Day 1 Start Date.</td>
</tr>
<tr>
<td></td>
<td>(For example, enter “5” for a grace period of five days.)</td>
</tr>
<tr>
<td></td>
<td>Debt Collect does not consider borrowers for collection if they have any burb activity within this grace period (for example, a payment, waiver, billing notice, or overdue items).</td>
</tr>
<tr>
<td></td>
<td>(For example, if the “Day 1” date is “4/24/2008”, the grace period is five days, and today’s date is “5/31/2008”, then Debt Collect uses the date range 4/24/2008 through 5/26/2008 as the dates that qualify for collection.)</td>
</tr>
<tr>
<td>Date to Use</td>
<td>Choose one of these options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Burb Entry.</strong> Choose this option if you want Debt Collect to use the date the entry was made in the burb table (a table containing borrower blocks) for the overdue item when choosing blocks for collection. (For more information, see the “Blocks” chapter of the <em>Circulation Guide.</em>)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Billing Notice.</strong> Choose this option if you want Debt Collect to use the date of the billing notices when choosing blocks for collection.</td>
</tr>
</tbody>
</table>
|                          | **NOTE**

  If you choose this, you must also choose a Billing Notice option (oldest or newest). Also, Debt Collect’s processing for this option is slower than for the Burb Entry option.

---

*Debt Collect Guide  3-25*
Chapter 3: Setting Up Debt Collect

6 Click Page Down to get to the next set of fields:

7 Complete or change these fields, as necessary:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Notice</td>
<td>If you chose the Billing Notice option for the Date to Use, choose one of these options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Oldest.</strong> Choose this option if you want Debt Collect to use the oldest billing notice date.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Newest.</strong> Choose this option if you want Debt Collect to use the billing notice date for the newest billing notice.</td>
</tr>
</tbody>
</table>
### Setting Up a Group

#### Location Kind

If you want to choose a location kind now, choose the type of location with which Debt Collect associates blocks. (You can also choose the Location Kind later when you do the steps in the task “Assigning Library Locations to a Group” on page 3-34):

- **Transacting Location.** This is the location from which borrowers have checked out items that are now overdue.

  For example, if you choose Transacting Location, then Debt Collect associates blocks (and their related fines) with the locations that performed the transactions. (This is useful if you want to collect fines for non-library-owned material or services [such as copying].)

- **Owning Location.** This is the location that actually owns the library material or has it in their catalog.

  For example, if you choose Owning Location, then Debt Collect associates blocks (and their related fines) with the locations that actually own the library material or have the material in their catalog.

#### Locations

You can define the locations to assign to this group for processing. For more information, see “Assigning Library Locations to a Group” on page 3-34.

#### Exclude Borrowers less than

If you want to exclude any young borrowers from qualifying for collection, enter the maximum age of borrowers who do not qualify for collection.

This is used to determine initial borrower eligibility to go to Debt Collect.

(For example, enter “18” if borrowers who are 18 years of age and younger do not qualify for collection.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Kind</td>
<td>If you want to choose a location kind now, choose the type of location with which Debt Collect associates blocks. (You can also choose the Location Kind later when you do the steps in the task “Assigning Library Locations to a Group” on page 3-34):</td>
</tr>
<tr>
<td></td>
<td>• <strong>Transacting Location.</strong> This is the location from which borrowers have checked out items that are now overdue.</td>
</tr>
<tr>
<td></td>
<td>For example, if you choose Transacting Location, then Debt Collect associates blocks (and their related fines) with the locations that performed the transactions. (This is useful if you want to collect fines for non-library-owned material or services [such as copying].)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Owning Location.</strong> This is the location that actually owns the library material or has it in their catalog.</td>
</tr>
<tr>
<td></td>
<td>For example, if you choose Owning Location, then Debt Collect associates blocks (and their related fines) with the locations that actually own the library material or have the material in their catalog.</td>
</tr>
<tr>
<td>Locations</td>
<td>You can define the locations to assign to this group for processing. For more information, see “Assigning Library Locations to a Group” on page 3-34.</td>
</tr>
<tr>
<td>Exclude Borrowers less than</td>
<td>If you want to exclude any young borrowers from qualifying for collection, enter the maximum age of borrowers who do not qualify for collection.</td>
</tr>
<tr>
<td></td>
<td>This is used to determine initial borrower eligibility to go to Debt Collect.</td>
</tr>
<tr>
<td></td>
<td>(For example, enter “18” if borrowers who are 18 years of age and younger do not qualify for collection.)</td>
</tr>
</tbody>
</table>
Chapter 3: Setting Up Debt Collect

8 Click Page Down to get to the next set of fields:

| Exclude Blocks | You can optionally define certain types of blocks that will be excluded from Debt Collect. The Exclude Block is used to determine initial borrower eligibility to go to Debt Collect. Therefore, if the Debt Collect Amount Due Threshold is $25.00 and lost blocks are excluded, a borrower owing $50.00, but with $30.00 of that in lost blocks, will not get sent to Debt Collect because their eligible balance is only $20.00, which is below the threshold value. If the same borrower gets an additional $5.00 non-lost charge added later, they will go to Debt Collect with a total balance of $55.00. Once a borrower has met all the criteria, they get sent for all charges they owe that belong to locations included in the Debt Group locations. |

9 Complete or change these fields, as necessary:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude Btypes</td>
<td>You can optionally specify the borrower type to exclude from collection. For more information, see “Excluding a BTYPE from Qualifying for Collection (Optional)” on page 3-38.</td>
</tr>
</tbody>
</table>
### Setting Up a Group

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td>Specify one or more email address IDs to which you want to send email reports. You can type an ID or click <strong>Codes</strong> and select the ID from the list of email addresses added to debt collect. For more information, see “Creating or Changing an Email Address” on page 3-6. You can add additional email addresses to the group by clicking <strong>New</strong> and typing an ID or clicking <strong>Codes</strong>. You can delete an email address from the group by selecting the email ID from the Email drop-down list and then clicking <strong>Delete</strong>.</td>
</tr>
<tr>
<td>SMTP Host</td>
<td>Enter the SMTP host (or name of the email server) for your library or consortia through which your library or consortia sends email messages. In an email address, this is usually all of the information after the “at” symbol (@). (For example, enter “mainlibrary.org”.)</td>
</tr>
<tr>
<td>Reply To Email Address</td>
<td>Enter the email address at your library or consortia to which the collection agency or others can send reply email messages.</td>
</tr>
<tr>
<td>From Name</td>
<td>Enter the name of the person to whom the email address belongs, or the person at your library or consortia that the collection agency or others can contact.</td>
</tr>
<tr>
<td>Report File Path</td>
<td>Enter the path name for the directory where you want all of the collection reports stored for this group. (For example, enter “C:\My Documents\Debt Collect\Reports\Group1”.)</td>
</tr>
</tbody>
</table>

**NOTE**

Debt Collect does not verify that you have a valid directory path, nor does it create a new directory if you enter one. You may want to make note of the directory you want or enter here, then manually create it while you are completing this field, or soon afterwards.
Chapter 3: Setting Up Debt Collect

10 Click Page Down to get to the last set of fields:

![Image of Edit: Debt Collection Group window]

11 Complete or change these fields, as necessary:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit Report ID</td>
<td>Type or select the report ID that you want Debt Collect to use for the Submit (or New) report for this group. A Submit or New report is a report of all new borrowers that qualify for collection since the last submit report. To select the ID, click Codes and select the ID from the list. For example, type “1”.</td>
</tr>
<tr>
<td>Submit Report Subject</td>
<td>Enter a short subject line for this Submit report’s email message. (For example, enter “New Collection Report from Main Library”.) This is a free-text box, so you can enter any information that you want to. However, you must limit your subject line to 80 characters.</td>
</tr>
<tr>
<td>Submit Report Body</td>
<td>Enter any introduction or explanation text (or whatever you want) for the body of this Submit report’s email message. (For example, enter “Here is a report of the new borrowers who are in collection.”) This is a free-text box, so you can enter any information that you want to. However, you must limit your body message text to 80 characters.</td>
</tr>
</tbody>
</table>
Setting Up a Group

12 Save your changes and Close the dialog box.

Assigning a Processing Fee to a Range of Fines
(Optional)

If you want to, you can assign a processing fee to a particular range of fine amounts, or a flat processing fee to all fines. This way, you can assess any processing or collection costs and pass them on to delinquent borrowers.

If you do not need a processing fee for a range of fines, you can change the fee and the fine amount, or you can delete them both completely.

This section explains these topics:

- Assigning a Processing Fee to a Fine or Changing a Fee or Fine
- Deleting a Processing Fee and Its Fine Range

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Report ID</td>
<td>Type or select the report ID that you want Debt Collect to use for the Update report for this group. An Update report is a list of borrowers who have had any kind of activity on their account—from a small payment to completely settling their account with the library—since the last Submit or Update report. To select the ID, click Codes and select the ID from the list. For example, type “2”.</td>
</tr>
<tr>
<td>Update Report Subject</td>
<td>Enter a short subject line for this Update report’s email message. (For example, enter “Update Collection Report from Main Library”.) This is a free-text box, so you can enter any information that you want to. However, you must limit your subject line to 80 characters.</td>
</tr>
<tr>
<td>Update Report Body</td>
<td>Enter any introduction or explanation text (or whatever you want) for the body of this Update report’s email message. (For example, enter “Here is a report of the borrowers who are no longer in collection.”) This is a free-text box, so you can enter any information that you want to. However, you must limit your body message text to 80 characters.</td>
</tr>
</tbody>
</table>
Assigning a Processing Fee to a Fine or Changing a Fee or Fine

When you assign a processing fee to a fine, you actually assign the fee to a range of fines. This way, you can decide how you want to assess processing fees. However, if you do not want to assign a processing fee to a range of fines, you can assign a flat processing fee to all fines.

For example, you can assign a processing fee of $1.00 to fines that range from $10.00 to $20.00, then a fee of $2.00 to fines that range from $20.00 to $30.00, and so forth. If you assigned processing fees to fines like this, then here is how Debt Collect would assign fees to a borrower:

- A fine amount of $7.00 would not be assessed a processing fee.
- A fine amount of $12.00 would be assessed a processing fee of $1.00.
- A fine amount of $20.00 would be assessed a processing fee of $2.00.

If you want to assess a processing fee for borrowers who owe less than the amount required for them to be considered for collection, you can do so by entering a range that begins with $0.00.

Before You Begin

If you want to pass on fees from your collection agency, find out what fees the collection agency charges your library for their services. If your library wants to charge your borrowers other fees for processing fines, find out what fees your library charges. Once you find out the fees you want to pass on, decide how you want them distributed in Debt Collect.

To assign a processing fee to a range of fines or to change a fee or fine

1. Be sure you are not running the Debt Collect Day End processes.
2. In the Horizon Client, go to Administration > Table Editor.
3. Select the debt_collect table, and then click OK.
   The Debt Collection Group dialog box displays.
4. Choose the group you want and click Edit.
   Debt Collect displays the Debt Collection Group Edit dialog box:
Choose one of the following tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Assign a flat processing fee to all fines | 1 Type a value of “0” for the **Fine** value.  
2 Enter the **Fee** to assign to all accounts sent to Debt Collect. For example, type “30” to always assess a $30.00 fee.  
3 **Save** your changes and **Close** the dialog box. |
| Assign a flat processing fee for all fines above a certain value | 1 Type the value for the **Fine** value that is the minimum for a fee to be assessed. For example, type “25”. Any borrowers with fines below $25.00 will not be assessed an additional fee.  
2 Enter the **Fee** to assign. For example, type “30” to assess a $30.00 fee.  
3 **Save** your changes and **Close** the dialog box. |
| Assign fees to a range of fines           | A range consists of two or more entries for Processing Fees. The lower number is the minimum value in the range. The higher number is minimum value in the next range, but it also defines the maximum value for the previous range, at a number 1 less than itself.  
For example, if you enter a Fine of $10 with a Fee of $1 and a Fine of $20 with a Fee of $2, fines less than $10 will not incur a fee, fines of $10 through $19 will incur a $1 fee, and fines greater than or equal to $20 will incur a $2 fee.  
**To assign fees to a range**  
1 Type the value for the **Fine** value that is the minimum for a fee to be assessed. For example, type “10”. Any borrowers with fines below $10.00 will not be assessed an additional fee.  
2 Type the **Fee** to assign for the fine. For example, type “1” to assess a $1.00 fee.  
3 Click **New**.  
4 Type the minimum **Fine** value for the next range of fines. For example, type “20”.  
5 Type the **Fee** to assign for this next range. For example, type “2”.  
6 Repeat steps 3-6 for each new range to add.  
7 **Save** your changes and **Close** the dialog box. |

**Deleting a Processing Fee and Its Fine Range**

If you do not use a processing fee for a range of fines, you can delete the row or rows in that range.

**To delete a processing fee and its fine range**

1 Be sure you are not running the Debt Collect Day End processes.
2 In the Horizon Client, go to **Administration** > **Table Editor**.
3 Select the **debt_collect** table, and then click **OK**.
Chapter 3: Setting Up Debt Collect

The Debt Collection Group dialog box displays.

4 Choose the group you want and click Edit.
   Debt Collect displays the Debt Collection Group Edit dialog box.

5 From the Processing Fees drop-down list, select the fine and fee that you want to delete.

6 Click Delete.
   Debt Collect deletes the fee and fine.

7 If you want to delete another fee and fine, repeat steps 5 through 6.

8 Save your changes and Close the dialog box.

Assigning Library Locations to a Group

Each group must have at least one location assigned to it. This lets Debt Collect know which locations to check to determine which borrowers to include in a collection report. If you have more than one library location that you want Debt Collect to include in a single report, you can specify which locations to include in that group. (The locations available for a group are those locations defined on your Horizon system.)

When you assign library locations to a group, you must also specify which kind of locations (location Kind) they are: transacting or owning. When you specify the kind of location, you are letting Debt Collect know which block entries to use in considering borrowers for collection. The location kind applies to all library locations that you assign to the group.

Here is a description of each location kind:

- **Transacting location.** This is a location that performs checkout and other transactions. Therefore, if you mark this location kind for all locations, then Debt Collect uses block entries relating only to transactions performed by the library location or locations in qualifying a borrower for collection. If you want to collect fines for non-library-owned material or billable services (such as copying), then you may want to choose the Transacting location kind.

- **Owning location.** This is a location that actually owns the library material or has it in their catalog. Therefore, if you mark this location kind for all locations, then Debt Collect uses block entries relating only to materials that the library location or locations own or have in their catalog in qualifying a borrower for collection.
For example, if you mark “Location1” and “Location2” to be included in a group, and you marked the Location Kind as “Transacting Location,” then Debt Collect uses only the block entries that transacted in Location1 and Location2. However, if you choose “Owning Location” for the Location Kind, then Debt Collect considers only the block entries for materials that are owned by Location1 and Location2.

**NOTE**

If the block entry is not for an item, and therefore has no owning location, then Debt Collect uses the transacting location.

**IMPORTANT**

Include each library location in only one Debt Collect group. Otherwise, borrowers will be included on more than one report and could be contacted and billed for overdue amounts for each report that they appear on. Contact Customer Support if you need to discuss including a library location in more than one group.

**To include other library locations in the collection process**

1. Be sure you are not running the Debt Collect Day End processes.
2. In the Horizon Client, go to Administration > Table Editor.
3. Select the debt_collect table, and then click OK.
   The Debt Collection Group dialog box displays.
4. Choose the group you want and click Edit.
   Debt Collect displays the Debt Collection Group Edit dialog box:

5. Click Page Down to get to page 2.
6. Select the Location Kind with which Debt Collect associates the blocks, if you have not already done so:
Chapter 3: Setting Up Debt Collect

- **Transacting Location.** This is the location from which borrowers have checked out items or received other billable services that are now overdue.
  
  For example, if you choose Transacting Location, then Debt Collect associates blocks (and their related fines) with the locations that performed the transactions. (This is useful if you want to collect fines for non-library-owned material or billable services [such as copying].)

- **Owning Location.** This is a location that actually owns the library material or has it in their catalog.
  
  For example, if you choose Owning Location, then Debt Collect associates blocks (and their related fines) with the locations that actually own the library material or have the material in their catalog.

7 Do one or more of these tasks, as necessary:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Include one or more library locations in this group | • If this is the first location you are adding, type the **Location** code (or click **Codes** and select the location from the list) for the library location to include in this group. (For example, type “main”.)
  • If you want to add a location to the existing list of locations, click **New**, and then type the **Location** code (or click **Codes** and select the location from the list) for the library location to include in this group. Repeat as necessary. |
| Remove one or more library locations from this group | 1 Select the location from the Locations drop-down list.
  2 Click **Delete**.
  3 Repeat as necessary. |

8 **Save** your changes and **Close** the dialog box.

---

**Excluding a Block Type from Qualifying for Collection (Optional)**

Debt Collect uses only certain block types from your system to qualify a borrower for collection, even if you have additional block types on your system. (For more information on blocks, see the “Blocks” chapter of the Circulation Guide.)

If a borrower has one of these block types, by default Debt Collect adds that borrower to a Debt Collect report:

- Adjustment credit, for changed amounts (adjcr)
- Adjustment debit, for changed amounts (adjdbt)
- Balancing Entry (balance)
- Claimed Return (cr)
- Damaged (damage)
- Force to DebtCollection (fdc)
- Fees (fee)
- Fine (fine)
- Lost (l)
- Found (fl)
- Lost Processing Fee (LostPro)
- Lost Recall (lr)
- Fine Payment (payment)
- Waiver of Fine (waiver)
Debt Collect Guide

Setting Up a Group

You can decide to exclude any of these block types from qualifying a borrower for collection. (For example, you may not want borrowers with a block type of “Fees” to go to collection.)

**To exclude a block type from qualifying for collection**

1. Be sure you are not running the Debt Collect Day End processes.
2. In the Horizon Client, go to Administration > Table Editor.
3. Select the `debt_collect` table, and then click OK. The Debt Collection Group dialog box displays.
4. Choose the group you want and click Edit.

Debt Collect displays the Debt Collection Group Edit dialog box:

5. Click Page Down to get to page 2.
6 Do one or more of these tasks, as necessary:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude one or more block types</td>
<td>If there are one or more Exclude Blocks for this group, you must click <strong>New</strong> before continuing, unless you want to change the currently selected Exclude Block. Type or choose (by clicking <strong>Codes</strong> and selecting from the list) the <strong>Block</strong> type that you want to exclude from qualifying a borrower for collection. For example, select and add the waiver (Waiver of Fine) code and then add the adjdbt (Adjustment debit, for changed amounts) code.</td>
</tr>
<tr>
<td>Include one or more block types</td>
<td>Select the block from the Exclude Blocks drop-down list, and then click <strong>Delete</strong>.</td>
</tr>
</tbody>
</table>

7 **Save** your changes and **Close** the dialog box.

**Excluding a BTYPE from Qualifying for Collection (Optional)**

By default, Debt Collect includes all borrower types (BTYPEs) as qualifying for collection. If you want to do so, you can exclude any of your BTYPEs from qualifying for collection. (For example, you may not want borrowers with a BTYPE of “juvenile” to go to collection.)

**To exclude a BTYPE from qualifying for collection**

1 Be sure you are not running the Debt Collect Day End processes.
2 In the Horizon Client, go to **Administration > Table Editor**.
3 Select the **debt_collect** table, and then click **OK**. The Debt Collection Group dialog box displays.
4 Choose the group you want and click **Edit**.
Debt Collect displays the Debt Collection Group Edit dialog box:

5. Click Page Down twice to get to page 3 of the record.

6. Do one or more of these tasks, as necessary:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Exclude one or more BTYPEs  | If there are one or more Exclude Btypes for this group, you must click **New** before continuing, unless you want to change the currently selected Exclude Btype.  
Type or choose (by clicking **Codes** and selecting from the list) the **Btype** code that you want to exclude from qualifying for collection.  
(For example, specify the code for a “juvenile” or “visitor” borrower type.)  
**NOTE**  
If you add all the Btypes to the list to exclude, then Debt Collect will not find any borrowers who qualify for collection and your reports will be empty. |
| Include one or more BTYPEs  | Select the Btype from the Exclude Btypes drop-down list, and then click **Delete**.                                                                                                                      |

7. **Save** your changes and **Close** the dialog box.
Completing the Setup for a Debt Collect Group

You complete the setup for a Debt Collect group by doing some or all of these tasks:

- If you have created more than one Debt Collect group, you must create a new menu option (or Day End process) for that group. This way, Horizon can run the Day End process for each group’s reports and send them in email messages.
- Make sure the Day End process for each group is set up to generate a report daily, weekly, or monthly, and to send the report in an email message, depending on what you and your collection agency have decided upon. (For more information, see “Coordinating with the Collection Agency” on page 3-4.)
- If you do not want Debt Collect to automatically send reports in email messages, you can also turn off this feature while you are completing your setup. You can do this now or later. (For more information or to do this later, see “Turning Off the Automatic Sending of Reports via Email” on page 4-7.)

Once you decide what you want, you must complete the setup steps for each Debt Collect report: the Submit (or New) report and the Update report.

This section explains these topics:

- Creating a New Day End Process for a New Group
- Completing the Setup for a Group

Creating a New Day End Process for a New Group

If you have created more than one Debt Collect group, you must create a new menu option (or Day End process) for that group. This way, Horizon can run the Day End process for each group’s reports and send them in email messages. You do this by copying the default Debt Collect Day End New and Update processes and changing them.

Before You Begin

As you create a new Day End process, you must enter the Group ID number for the new group. Take note of the Group ID number for each new group that you have created. Debt Collect automatically assigns the Group ID number when you create and save the group. To see this Group ID number, open the main Debt Collect for Horizon window and look at the Group ID field under “Groups” at the top of the window. (For more information, see “Changing a Group” on page 3-21.)

Also, you must enter the Option number for the Day End process. (This is the number for the order in which you want Horizon to run this Day End process.) You must be aware of these things when choosing the Option number:

- Be sure that you run the Debt Collect Day End processes last—after all of your other Day End processes. This is because Horizon needs to completely update your database with blocks, fines, and so forth before you run the Debt Collect Day End processes.
- Be sure that you do not enter a duplicate option number. To do this, open the menu view in the Table Editor and check the numbers for the other MDayEnd menu options. (For related instructions, see “Activating the Day End Processes for Debt Collect” on page 4-4.)
- Be sure the option numbers for the new Day End processes are larger than the option numbers for the default Day End processes.
- With each set of Day End processes, be sure the Submit (New) Day End process option number is larger than the option number for the Update Day End process.
• Enter the option number for each Debt Collect Day End process in increments of one number. This way, Horizon can run all of the Debt Collect Day End processes at once, and other Day End processes will not affect the database between the running of each Debt Collect Day End process.

To create a new Day End process for a new group

1. Open the menu_option view in the Table Editor.
   Horizon displays the List Menu Options window.

2. Highlight the DeDebtN menu option to copy the Day End Debt Collection New process.

3. Choose File, Copy Record.
   Horizon displays the Edit Menu Option window:

```
Menu Option: eDebtN
Description: Day End Debt Collection - New
Program Name: Fund5 lee
Arguments: Any A0 n 0
Secured: False
Privilege No.:
Help Panel ID: 
Listed On: New

Menu: MDayEn
This is a dummy menu for day end options:
Option No.: 75
```

4. Change these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Option</td>
<td>Enter a new menu option code. (For example, enter “DeDetN2” or “DeDCN2”).</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a new description. (For example, enter “Day End Debt Collection - New (Group 2)”.)</td>
</tr>
</tbody>
</table>
### Arguments
Change the number after the Group switch (\( /g \)) to the Group ID number for the new group.
(For example, the new argument may look something like this: “/w /g2 n e”.)

**NOTE**
Debt Collect automatically assigns the Group ID number when you create and save the group. To see this Group ID number, open the main Debt Collect for Horizon window and look at the Group ID field under “Groups” at the top of the window. (For more information, see “Changing a Group” on page 3-21.)

### Option No.
1. Decide which option number you want for this Day End process.
   - To be sure that you do not enter a duplicate option number, you can check the numbers in the List Menus window that already exist for the MDayEnd menu. (To see this window, choose Window, List: Menus.)

   **IMPORTANT**
   Be sure the option number for the new Day End process are larger than the option number for the default Day End processes. With each set of Day End processes, be sure the Submit (New) Day End process option number is larger than the option number for the Update Day End process. Also, enter the option number for each Debt Collect Day End process in increments of one number. This way, Horizon can run all of the Debt Collect Day End processes at once, and other Day End processes will not affect the database between the running of each Debt Collect Day End process.

2. In the **Option No.** field on the Edit Menus window, enter the number for the order in which you want this Day End option to occur in the list of Day End options.
5 If you want to change when Debt Collect creates and sends a report for this Day End process, or turn off Debt Collect’s ability to send reports automatically via email for this group, continue with the task “Completing the Setup for a Group” on page 3-43, then return to this task.

You must be sure that you create a new Day End process for both the Day End Debt Collect New and the Day End Debt Collect Update processes.

6 Save your changes.

7 Highlight the DeDebtU menu option to copy the Day End Debt Collection Update process.

8 Repeat steps 3 through 6 to complete the setup for the DeDebtU menu option.

NOTE
If you have created other Debt Collect groups, then be sure to repeat steps 2 through 6 for each of those groups.

Completing the Setup for a Group

To complete the setup for a group, you should make sure the Day End process for each group is set up to generate a report daily, weekly, or monthly, and to send the report in an email message, depending on what you and your collection agency have decided upon. (For more information, see “Coordinating with the Collection Agency” on page 3-4.)

If you do not want Debt Collect to automatically send reports in email messages, you can also turn off this feature while you are completing your setup. You can do this now or later. (For more information or to do this later, see “Turning Off the Automatic Sending of Reports via Email” on page 4-7.)

Once you decide what you want, you must complete the setup steps for each Debt Collect report: the Submit (or New) report and the Update report.

To complete the setup for a group

1 Open the menu option view in the Table Editor.
   Horizon displays the List Menu Options window.

2 Double-click the DeDebtN menu option to change the Day End Debt Collection New process.
Horizon displays the Edit Menu Option window:

3 Do one or both of these tasks, as necessary:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Verify or change when Day End generates a report and sends it in an email message | Do one of these options:  
- If you want Debt Collect to create and send a report daily, make sure the first switch in the Arguments field is “/d”.  
- If you want Debt Collect to create and send a report weekly, make sure the first switch in the Arguments field is “/w”.  
- If you want Debt Collect to create and send a report monthly, make sure the first switch in the Arguments field is “/m”. |
| Turn off automatically sending a report via email | In the Arguments field, delete the “e” at the end of the field. |

4 Save your changes.

5 Double-click the DeDebtU menu option to change the Day End Debt Collection Update process.
6  Repeat steps 3 and 4 to complete the setup for the DeDebtU menu option.

**NOTE**

If you have created new Day End processes for other Debt Collect groups, then be sure to repeat steps 2 through 4 for each of those Day End processes.

---

**Deleting a Group**

If you no longer use a group in Debt Collect, you can delete it. After you delete the group in Debt Collect, you should also delete the related Day End processes for that group.

**To delete a group**

1  Be sure that you are not running the Debt Collect Day End processes.
2  In the Horizon Client, go to **Administration > Table Editor**.
3  Select the **debt_collect** table, and then click **OK**.  
   The Debt Collection Group dialog box displays.
4  Choose the group you want to delete.
5  Go to **File > Delete Record**.
6  Click **OK** to confirm the deletion. 
   Debt Collect deletes the group from the list of groups.
7  Open the **menu** view in the Table Editor. 
   Horizon displays the List Menus window.
8  Highlight the Day End process that you want to delete.
9  Choose **File > Delete Record**.
10 Click **OK** to confirm the deletion. 
    Horizon deletes the Day End process.
This chapter explains how to activate the Debt Collect Day End processes, and then run them.

About Day End Processes 4-3
Activating the Day End Processes for Debt Collect 4-4
Turning Off the Debt Collect Day End Processes 4-5
Turning Off the Automatic Sending of Reports via Email 4-7
Understanding File Naming Conventions for Reports 4-9
Deleting a Borrower from Debt Collect 4-10
About Day End Processes

Debt Collect works automatically at Day End: it gathers the report of delinquent borrowers and sends the report to the collection agency via email. Since Debt Collect works automatically with Day End, you must activate the Debt Collect Day End process for each group’s Submit (New) and Update reports.

Debt Collect delivers one default Day End process for the Submit (New) reports and one for the Update reports; these Day End processes are for the default group that Debt Collect delivers. If you create more groups, then you must create more Day End processes. (For instructions, see “Creating a New Day End Process for a New Group” on page 3-40.)

If you ever need to make changes to groups or reports or anything else in Debt Collect, you should turn off the Day End processes for each group’s New and Update reports. (For instructions, see “Turning Off the Debt Collect Day End Processes” on page 4-5.)
Activating the Day End Processes for Debt Collect

When you first set up Debt Collect, you need to activate the day end processes. You also need to add more processes and activate them when you add a new Debt Collect group.

To activate the Day End processes for Debt Collect

1. Open the menu view in the Table Editor. Horizon displays the List Menus window.
2. Double-click the Day End Debt Collection New menu option for the MDESave menu. Horizon displays the Edit Menus window:

   ![Edit Menus window](image)

   - **Menu**: DayEnd
   - **Menu Option**: Day End Debt Collection - New
   - **Option No**: 75

   Clicking the `Save` button will save these changes.
3 Change these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>Enter MDayEnd. This activates the process for Day End.</td>
</tr>
<tr>
<td>Option No.</td>
<td>1 Decide which option number you want for this Day End process.</td>
</tr>
<tr>
<td></td>
<td>To be sure that you do not enter a duplicate option number, you can check</td>
</tr>
<tr>
<td></td>
<td>the numbers in the List Menus window that already exist for the MDayEnd</td>
</tr>
<tr>
<td></td>
<td>menu. (To see this window, choose Window, List: Menus.)</td>
</tr>
<tr>
<td></td>
<td>IMPORTANT</td>
</tr>
<tr>
<td></td>
<td>Be sure the option number for the new Day End process are larger than the</td>
</tr>
<tr>
<td></td>
<td>option number for the default Day End processes. With each set of Day End</td>
</tr>
<tr>
<td></td>
<td>processes, be sure the Submit (New) Day End process option number is larger</td>
</tr>
<tr>
<td></td>
<td>than the option number for the Update Day End process. Also, enter the option</td>
</tr>
<tr>
<td></td>
<td>number for each Debt Collect Day End process in increments of one number.</td>
</tr>
<tr>
<td></td>
<td>This way, Horizon can run all of the Debt Collect Day End processes at once,</td>
</tr>
<tr>
<td></td>
<td>and other Day End processes will not affect the database between the running</td>
</tr>
<tr>
<td></td>
<td>of each Debt Collect Day End process.</td>
</tr>
<tr>
<td></td>
<td>2 In the Option No. field on the Edit Menus window, enter the number for the</td>
</tr>
<tr>
<td></td>
<td>order in which you want this Day End option to occur in the list of Day End</td>
</tr>
<tr>
<td></td>
<td>options.</td>
</tr>
</tbody>
</table>

4 Save your changes.

5 Double-click the Day End Debt Collection Update menu option for the MDESave menu.

6 Repeat steps 3 and 4 to activate the Debt Collect Day End Update process.

NOTE

If you have other Submit (New) and Update Day End Debt Collection processes for other groups, double-click each Day End process and repeat steps 2 through 4 for each Day End process.

Turning Off the Debt Collect Day End Processes

Debt Collect works automatically at Day End: it gathers the report of delinquent borrowers and sends the report to the collection agency via email. Since Debt Collect works automatically with Day End, you must activate the Debt Collect Day End process for each group’s Submit (New) and Update reports.

However, if you ever need to make changes to groups or reports or anything else in Debt Collect, you should turn off the Day End processes for each group’s Submit (New) and Update reports.
To turn off the Day End processes

1. Open the menu view in the Table Editor. Horizon displays the List Menus window.
2. Double-click the Day End Debt Collection New menu option for the MDayEnd menu. Horizon displays the Edit Menus window.
3. In the Menu field, enter MDESave.
4. Save your changes.
5. Double-click the Day End Debt Collection Update menu option for the MDayEnd menu.
6. Repeat steps 3 and 4 to turn off the Debt Collect Day End Update process.

**NOTE**
If you have other Submit (New) and Update Day End Debt Collection processes for other groups that you want to turn off, double-click each Day End process and repeat steps 2 through 4 for each Day End process.

7. When you are finished making changes to Debt Collect, activate the Day End processes again.
   (For instructions, see “Activating the Day End Processes for Debt Collect” on page 4-4.)
Turning Off the Automatic Sending of Reports via Email

Debt Collect is delivered with the ability of sending reports in an email message activated. If you do not want Debt Collect to automatically send reports via email, you can keep it from doing so.

If you decide that you do want to have Debt Collect automatically send reports in an email message, you can activate it again.

This section explains these topics:

- Turning Off the Automatic Sending of Reports via Email
- Activating the Automatic Sending of Reports via Email

Turning Off the Automatic Sending of Reports via Email

If you do not want Debt Collect to automatically send reports via email, you can keep it from doing so. (For example, since Debt Collect does not encrypt the borrower information in the email message, you may want to encrypt the report information with encryption software before sending it in an email message.) If you do this, then you must send the reports manually using email or by printing them and mailing them.

You may decide to send some reports (such as the Update report) via email, but not the Submit (New) report.

To turn off the automatic sending of reports via email

1. Open the menu option view in the Table Editor. Horizon displays the List Menu Options window.

2. Double-click the menu option for the Day End Debt Collect process you want. (For example, double-click the “DeDebtN” menu option to turn off sending reports via email for the Day End Debt Collection New process.) Horizon displays the Edit Menu Option window:
3 In the **Arguments** field, delete the “e” at the end of the field.

**NOTE**

The “n” argument indicates that this is a Submit (New) report, while a “u” argument indicates that it is an Update report.

4 Save your changes.

5 Repeat steps 2 through 4 to for each Day End Debt Collect process for which you want to turn off automatically sending reports via email.

6 When your collection agency needs a report, you must now either send it manually in an email message or print it and mail it.

(For instructions on printing a report, see “Printing a Submit (New) or Update Report” on page 5-3.)

---

### Activating the Automatic Sending of Reports via Email

Debt Collect is delivered with sending reports in an email message activated. If you have turned off this feature, and then decide that you do want to have Debt Collect automatically send reports in an email message, you can activate it again.

**To activate the automatic sending of reports via email**

1 Open the **menu_option** view in the Table Editor.
   Horizon displays the List Menu Options window.

2 Double-click the menu option for the Day End Debt Collect process you want.
   (For example, double-click the “DeDebtN” menu option to activate sending reports in an email message for the Day End Debt Collection New process.)

   Horizon displays the Edit Menu Option window:

![Edit Menu Options](image)

**Menu Option**: DeDebtN

**Description**: Day End Debt Collection - New

**Program Name**: Fundc.bat

**Arguments**: [u/v]n e

**Menu**: User-Defined

**Secure**: 

**Listed On (Menus)**: MDayEn

**Option No.**: 75

---

*This is a dummy menu for dayend options*
3 In the **Arguments** field, enter an “e” at the end of the field.

**NOTE**

You may have to enter a space before the “e” if there is not already a space there.

4 Save your changes.

5 Repeat steps 2 through 4 to for each Day End Debt Collect process for which you want to activate automatically sending reports via email.

## Understanding File Naming Conventions for Reports

Some tasks in this chapter guide you in working with the report files directly. To work with the report files, you should be familiar with the file naming conventions for each report. This way, you can more easily find a report that you are looking for.

When Debt Collect generates reports (either daily or weekly), it automatically saves it to the directory you specify for the related group. (For instructions on specifying this directory, see “Changing a Group” on page 3-21.) Debt Collect also automatically names the report file.

Here is an example of some Submit (New) and Update report file names:

- 1_020531n1.txt
- 1_020531u1.txt
- 1_020531n2.txt
- 1_020531u2.txt
- 2_020531n1.txt
- 2_020531u1.txt
- 2_020531n2.txt
- 2_020531u2.txt

Here are the parts to a report file name:

- **Group ID number**
- **Type of report:** Submit (New) or Update
- **Current day’s date (YYMMDD)**
- **Debt Collect saves the reports as a text (.txt) file.**

If you run the Day End processes more than once in a day and Debt Collect is generating reports, then Debt Collect numbers the reports for the day.
Deleting a Borrower from Debt Collect

If you want to, you can manually delete a borrower from Debt Collect. Before you delete a borrower, you should coordinate with your collection agency to make sure that you both agree on which borrowers can be deleted from Debt Collect. (This task does not delete a borrower from Horizon, only from Debt Collect.)

To delete a borrower from Debt Collect

1. In the Horizon Client, go to Administration > Table Editor.
2. Select the debt_borrower table, and then click OK.
   The Debt Borrower list dialog box displays:

3. Select the borrower that you want to delete.
4. Go to File > Delete Record.
5. Click OK to confirm the deletion.
   Debt Collect deletes the borrower from the list.
6. Save your changes.
Working with Reports

This chapter explains how to print your own reports, generate a current report of all borrowers in Debt Collect, and so forth.

About Working with Reports 5-3
Printing a Submit (New) or Update Report 5-3
Viewing Information about Borrowers and Their Blocks 5-4
Archiving or Deleting Old Debt Collect Reports and Files 5-7
About Working with Reports

After you set up Debt Collect, you may need to work with the generated reports.

To work with the report files, you should be familiar with the file naming conventions for each report (for more information, see “Understanding File Naming Conventions for Reports” on page 4-9).

Debt Collect stores past reports in a specific directory on the computer. From that directory, you can view and print current and past reports as well as manually archive older reports.

This chapter explains these topics:

- Printing a Submit (New) or Update Report
- Viewing Information about Borrowers and Their Blocks
- Archiving or Deleting Old Debt Collect Reports and Files

Printing a Submit (New) or Update Report

If you need to, you can print any Submit (New) or Update report. (For example, you may need to print a report because you turned off the automatic sending of a report in an email.)

To help you find the report that you want, you may want to be familiar with the file naming conventions for each report. (For more information, see “Printing a Submit (New) or Update Report” on page 5-3.)

Before You Begin

If you do not remember which directory you specified where Debt Collect should save the reports for the group that you want, find the directory. To do this, use these steps:

1. Open the main Debt Collect for Horizon window.
2. Double-click the group for which you want to print the report.
   Debt Collect displays the Group Edit window.
3. Click the Reports and Email tab at the top of the Group Edit window.
4. In the Report File Path field, view the directory path and make note of it.

To print a Submit (New) or Update report

1. Go to the directory location on your computer where Debt Collect reports are stored.
2. Open the report that you want in WordPad or other word processing software. Opening your reports in one of these software programs helps keep the formatting for better readability.
3. Print the report using the print features in WordPad or your word processing software program.
Chapter 5: Working with Reports

Viewing Information about Borrowers and Their Blocks

While you are in Debt Collect’s Administration software, you can view information about borrowers and their blocks currently in Debt Collect.

To view information about borrowers and their blocks

1. In the Horizon Client, go to Administration > Table Editor.
2. Select the debt_borrower table, and then click OK.

The List: Debt Borrower window displays:

3. To view more information about a borrower, select the borrower and click Edit.
The **Edit: Debt Borrower** dialog box displays:

![Edit: Debt Borrower dialog box](image)

4 Click **Close** to return to the list.
5 When you are finished viewing information about borrowers and their blocks, exit the **List: Debt Borrower** window.

### Changing the Display of the Debt Borrower List

You can change the sorting and columnar display in the List: Debt Borrower window.

**To change the display of the Debt Borrower list**

1 In the Horizon Client, go to **Administration > Table Editor**.
2 Select the **debt_borrower** table, and then click **OK**.
3 To change the sort method used, click **Sort**.
Chapter 5: Working with Reports

The Choose Sort Columns dialog box displays.

Do the following:

1. Select one or more columns from the list (up to a maximum of 15).
   The columns reorder in the list according to the order in which you select them. Thus, the order of sort depends on the order of the columns in the list. For example, in the preceding image, the list is sorted first by Borrower#, then by the Group ID, then the Last Date, the Total Amount, updates, and finally by the Name.

2. Select **Descending sort** to reverse the sort order (from A-Z to Z-A and from 0-9 to 9-0). This changes the sort order for all the columns.

3. Click **OK** to save the changes.

To change the display of columns, click **Display**.

The Display Options dialog box displays.

Do the following:

1. Select the columns that display by highlighting the appropriate ones. Clicking a highlighted column turns off its highlighting and hides the column in the Email list dialog box.
Archiving or Deleting Old Debt Collect Reports and Files

To keep your reports up-to-date and organized, you may want to archive or delete old reports on a regular basis.

Also, Debt Collect maintains a “debtcollect.log” file, which contains a log of all Debt Collect activities. (SirsiDynix Customer Support can use this file to help you troubleshoot any problems you may have with using Debt Collect.) You may want to archive or delete this log file routinely.

To archive old Debt Collect files and reports, you should decide where you want to store them. You can copy them to a backup server, a disk or CD-ROM, or all of these options.

This section explains these topics:

- Archiving and Deleting Old Debt Collect Reports
- Archiving and Deleting Old Files

Archiving and Deleting Old Debt Collect Reports

You can organize your old reports and keep your hard drive clean by archiving old Debt Collect reports.

To archive and delete old Debt Collect reports

1. Find the directory you specified to which Debt Collect should save the reports for each group that you want.

To do this, use these steps:

1. Open the main Debt Collect for Horizon window.
2. Double-click the group for which you want to print the report.
   Debt Collect displays the Group Edit window.
3. Click the Reports and Email tab at the top of the Group Edit window.
4. In the Report File Path field, view the directory path and make note of it.
Chapter 5: Working with Reports

2 Use the directory path to find the report files and copy or move them to the place where you want to store the files (backup server, a disk or CD-ROM, or all of these options).

To find the report files, use any Windows feature that you normally use to search your hard drive for files, such as My Computer or Windows Explorer.

3 After you archive the reports, delete the files in the same way as you would any Windows file.

(For example, right-click on the file and choose Delete.)

Archiving and Deleting Old Files

You can organize your old “debtcollect.log” files and keep your hard drive clean by archiving old “debtcollect.log” files. (Customer Support uses this file of Debt Collect activities to help you troubleshoot any problems you may have with using Debt Collect.)

To archive and delete old files

1 Use the directory path to find the “debtcollect.log” file and copy or move it to the place where you want to store the file (backup server, a disk or CD-ROM, or all of these options).

To find the file, use any Windows feature that you normally use to search your hard drive for files, such as My Computer or Windows Explorer.

The default directory is the folder in which you have your Horizon client software installed.

2 After you archive the “debtcollect.log” file, delete the file in the same way as you would any Windows file.
Index

A
Address
  email setup
    creating or changing 3-6
    deleting 3-8
Administration software
  overview 1-9
Adobe Acrobat Reader
  downloading from the Web 1-4
Age
  using to exclude borrower 3-27
Amount
  minimum owed 3-24
  reported by location 3-12
Amount Due Threshold field 3-24
Arguments field 3-42, 3-44, 4-8, 4-9

B
Basics
  Debt Collect 1-7
  Horizon 1-5
Billing notice
  date to use 3-26
Billing Notice field 3-26
Billing Notice option 3-25
Block
  choosing by date 3-25
  viewing in Debt Collect 5-4
Block type
  excluding from collection 3-36
  including in collection 3-38
  used by DebtCollect 3-36
Bold typeface
  convention for 1-5
Borrower
  deleting from Debt Collect 4-10
  excluding by age 3-27
  viewing
    included Debt Collect blocks 5-4
Borrower circulation type
  (see BTYPE)
BTYPE (borrower circulation type)
  excluding from collection 3-38
  including in collection 3-39
Burb Entry option 3-25
Business phone number
  setting up its specifier 3-14
Buttons
  (see Option)

C
Check box
  (see Fields)
Click
  defined 1-5
Collection (financial)
  excluding BTYPE 3-38
Collection agency
  automatic email
    turning off 4-7
    turning on 4-8
  coordinating with 3-4
  email address 3-6
Conventions
  for guide 1-5
  for report file names 4-9

D
Daily report
  generating 3-43
Database login 2-5
Date Grace Period field 3-25
Date to use
  for choosing blocks 3-25
Day 1 Start Date field 3-24
Day End
  activating for Debt Collect 4-4
  creating process for a group 3-40
  Day End Debt Collection New menu option 4-4, 4-6
  Day End Debt Collection Update menu option 4-5, 4-6
  DeDebtN menu option 3-41, 3-43
  DeDebtU menu option 3-43, 3-44
  group ID number 3-40
  running Debt Collect processes
    frequency 3-44
  software, installing 2-5
  turning off 4-5
Day End Debt Collection New menu option 4-4, 4-6
Day End Debt Collection Update menu option 4-5, 4-6
Debt Collect
  Administration software overview 1-9
  archiving reports and files 5-7
  BTYPE, excluding 3-38
  coordinating with collection agency 3-4
  Day End process
    creating for a group 3-40
    turning off 4-5
  deleting old reports and files 5-7
  email address
    setup 3-6
    fee setup 3-31
  group setup
    finalizing 3-40
Index

overview 3-18
installing
  Day End Process software 2-5
  Java software 2-4
overview 2-3
location, assigning to a group 3-34
logging in 2-5
overview
  Administration software 1-9
  setup 3-3
  tasks 1-7
report
  setup 3-11
setup
  fee 3-31
  group, finalizing 3-40
  group, overview 3-18
  overview 3-3
  report 3-11
system requirements 2-3
tasks overview 1-7
viewing
  borrowers with included Debt Collect blocks 5-4
DebtCollect
  block type 3-36
debtcollect.log file
  archiving or deleting 5-8
  defined 5-7
DeDebtN menu option 3-41, 3-43
DeDebtU menu option 3-43, 3-44
Dialog box
  (see Windows)
Directory
  for storing reports 3-29
Disclaimer 1-4
Documentation
  sending feedback about 1-4
Double-click
  defined 1-5
Drag
  defined 1-5

E
Edit Menu Option window 3-41
Edit Menus window 4-4
Email
  automatically sending reports 4-8
  body setup 3-30
  frequency of reports 3-44
  report, changing when sent 3-44
  subject line setup 3-30
  turning off automatic reports 3-43, 4-7
Email address
  for collection agency responses 3-28
  for documentation 1-4
  for your library 3-28
  number of groups that reference 3-8
  setup
    creating or changing 3-6
deleting 3-8
Email Address field 3-8
Exclude Borrowers less than field 3-27

F
Fee
  assigning
    to a new range of fines 3-32
    to borrowers 3-31
  deleting 3-33
Feedback about this guide
  sending to SirsiDynix 1-4
Field
  adding to a report 3-12
  changing on a report 3-12
  deleting from a report 3-12
  ordering on a report 3-12
  specifier, setting up 3-14
Fields
  Amount Due Threshold 3-24
  Arguments 3-42, 3-44, 4-8, 4-9
  Billing Notice 3-26
  Date Grace Period 3-25
  Day 1 Start Date 3-24
  Email Address 3-8
  Exclude Borrowers less than 3-27
  From Name 3-29
  Group ID 3-23, 3-32, 3-34, 3-35, 3-37, 3-39
  Menu 4-5
  Menu Option 3-41
  Name
    on Email Recipient Pool window 3-8
    on Group Edit window 3-23
    on Report Edit window 3-13
  Option No.
    on Edit Menu Option window 3-42
    on Edit Menus window 4-5
  requirements 3-40
  Organization 3-8
  Reply To Email Address 3-29
  Report File Path 3-29
  Seq 3-14
  SMTP Host 3-29
  Submit Report Body 3-30
  Submit Report ID 3-30
  Submit Report Subject 3-30
  Update Report Body 3-31
  Update Report ID 3-31
  Update Report Subject 3-31
File
  archiving or deleting 5-7
  debtcollect.log 5-8
  naming conventions for reports 4-9
File path
  for reports 3-29
Fine
  processing fee
    assigning 3-31
    changing 3-31
Index

Debt Collect Guide

G

Grace period
specifying 3-25

Group
block type
excluding from collection 3-36
including in collection 3-38

BTYPE
excluding from collection 3-38
including in collection 3-39
creating Day End process for 3-40
creating or changing 3-21
daily reports 3-43
defined 3-18
deleting 3-45
deleting processing fees 3-33
email setup
activating automatic reports 4-8
library 3-28
turning off automatic reports 4-7
location
assigning 3-34
excluding 3-36
monthly reports 3-43
overview of tasks 3-19
processing fees, assigning 3-31
setting up 3-40
weekly reports 3-43

Group ID
for Day End processes 3-40

Group ID field 3-23, 3-32, 3-34, 3-35, 3-37, 3-39

Group Edit window 3-23, 3-32, 3-34, 3-35, 3-37, 3-39
Name and Selection tab 3-23, 3-32, 3-34, 3-35, 3-37, 3-39

Guide
conventions 1-5
disclaimer 1-4
online version 1-4
overview of chapters 1-3
sending feedback about 1-4

H

Highlight
defined 1-5

Horizon
list of basic tasks 1-5

I

Install
Day End Process software 2-5
Debt Collect, overview 2-3
Java software 2-4
Italic typeface

J

Java
installing software 2-4

K

Keyboard
conventions for 1-5

L

Library
(see Location)

Location
assigning to a group 3-34
excluding from a group 3-36
owning, defined 3-34
transacting
defined 3-34
types, defined 3-34
using to separate amounts on a report 3-12

Location kind
for associating blocks 3-27

Login
Debt Collect 2-5

M

Manual
conventions 1-5
disclaimer 1-4
online version 1-4
overview of chapters 1-3
sending feedback about 1-4

Menu field 4-5

Menu option
Day End Debt Collection New 4-4, 4-6
Day End Debt Collection Update 4-5, 4-6
DeDebtN 3-41, 3-43
DeDebtU 3-43, 3-44
Menu Option field 3-41
menu view 4-4, 4-6
menu_option view 3-41, 3-43, 4-7, 4-8

Monthly report
generating 3-43

Mouse
conventions for 1-5

N

Name field
on Email Recipient Pool window 3-8
on Group Edit window 3-23
on Report Edit window 3-13
New report
  creating or changing 3-12
  defined 3-11
  printing 5-3
New user information 1-5
Newest option 3-26

O

Oldest option 3-26
Online documentation 1-4
Option No. field
  on Edit Menu Option window 3-42
  on Edit Menus window 4-5
requirements 3-40
Options
  Billing Notice 3-25
  Burb Entry 3-25
  Newest 3-26
  Oldest 3-26
  Owning Location 3-27, 3-36
  Transacting Location 3-27, 3-36
Organization field 3-8
Owning location
  defined 3-34
Owning Location option 3-27, 3-36

P

Path name
  for reports 3-29
PDF version of Horizon guides
  accessing on the SirsiDynix web site 1-4
Printing
  Debt Collect reports 5-3
Process
  disclaimer about 1-4
Processing fee
  assigning or changing 3-31
  deleting 3-33

R

Radio button
  (see Options)
Reply To Email Address field 3-29
Report
  archiving 5-7
  automatic sending in email
    activating 4-8
    turning off 4-7
  changing frequency 3-44
  creating or changing 3-12
  daily 3-43
  deleting
    from hard drive 5-7
  example 3-5
  fields

Changing 3-12
file path 3-29
for collection agency 3-4
generating 3-43
monthly 3-43
naming conventions 4-9
overview 3-11
printing 5-3
saving 5-7
scheduling with collection agency 3-4
separating amounts by location 3-12
specifier, setting up 3-14
Submit (New), defined 3-11
turning off automatic email 3-43, 4-7
Update, defined 3-11
weekly 3-43
Report Edit window 3-13, 3-15
Report File Path field 3-29
Report ID
  on Group Edit window 3-30, 3-31
Requirements
  system 2-3
Right-click
  defined 1-5

S

Sample screens
  disclaimer 1-4
Seq field 3-14
Setup
  block type, excluding 3-36
  BTYPE, excluding 3-38
  coordinating with collection agency 3-4
  Day End process for a group 3-40
  email address 3-6
  fee 3-31
  group
    finalizing 3-40
    overview 3-18
  location 3-34
  overview 1-7, 3-3
  reports 3-11
  specifier 3-14
SMTP Host field 3-29
Software
  overview 1-9
SPUD parameters
  in Debt Collect 2-5
Subject line
  for report and email setup 3-30
Submit (New) report
  creating or changing 3-12
  defined 3-11
  printing 5-3
Submit Report Body field 3-30
Submit Report ID field 3-30
Submit Report Subject field 3-30
System requirements 2-3
Index

T
Tabs
   Name and Selection 3-23, 3-32, 3-34, 3-35, 3-37, 3-39
Threshold
   amount due 3-24
Transacting location
   defined 3-34
Transacting Location option 3-27, 3-36

U
Update report
   creating or changing 3-12
   defined 3-11
   printing 5-3
Update Report Body field 3-31
Update Report ID field 3-31
Update Report Subject field 3-31

V
Views
   menu 4-4, 4-6
   menu_option 3-41, 3-43, 4-7, 4-8

W
Weekly report
   generating 3-43
Windows
   Edit Menu Option 3-41
   Edit Menus 4-4
   Group Edit 3-23, 3-32, 3-34, 3-35, 3-37, 3-39
   List Menu Options 3-41, 3-43
   Report Edit 3-13, 3-15
Windows operating system
   disclaimer about 1-4
Workflow
   overview for Debt Collect 1-7